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1. Prerequisites 

2. Document Conventions 

3. Procedural Notes 

4. Creating Tables in MS Access 

5. Finding Matched Records Using Queries in MS Access 

6. Finding Duplicate Records Using Primary Key CPA ID in Matches Query in MS 

Access 

7. Finding Duplicate Records Using Primary Key FIP ID in Matches Query in MS 

Access 

8. Finding Unmatched Records Between CPA Table and Matches Query in MS 

Access 

9. Finding Unmatched Records Between FIP Table and Matches Query in MS 

Access 

10. Exporting Access Query Data to MS Excel 

1. Prerequisites 

1.1. Access to FIP 

1.2. Access to CPA Direct 

1.3. Microsoft (MS) Excel 

1.4. Microsoft (MS) Access 

1.5. Two (or more) files generated from reports 

Back to top 

2. Document Conventions 

2.1. Menu and Dialog Box names are in bold. 

2.2. Variables are in italics. 

2.3. Mouse clicks and selections are in boxes. 

2.4. NOTES are underlined. 

Back to top 

3. Procedural Notes 

3.1. The procedure described below is used to create a file (or files) that can be used for 

comparison purposes. While the specific data fields listed in this document are 
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sufficient for that purpose, other/additional data fields may be required for other 

investigative tasks. 

3.2. The expected elapsed time to complete each procedure outlined in this document is 

between 20 and 30 minutes (including time to export the data to Excel). 

3.3. Ensure Excel files to be downloaded are closed before beginning the data import to 

Access. 

3.4. The parameters selected during the procedures outlined in this document reflect 

specific comparisons and do not include all possible permutations. Several additional 

queries and comparisons are possible using Access but are not normally performed 

as part of the comparison / investigation process.  

Back to top 

 

4. Creating Tables in MS Access 

4.1. Open MS Access. 

4.2. Double click the Blank Database icon in the MS Access application workspace. See 

figure 4.1. 

Figure 4.1. Blank Database icon in Access. 
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4.3. Close the default blank table by clicking the table close icon ( X ) in the upper right 

corner of the default table. See figure 4.2 (below). 

NOTE: Do not close the program using the similar close icon in the far upper right corner of the 

Access display. If Access is closed in this manner work may not be saved. See figure 4.2. 

Figure 4.2. Table close icon (green) and Access close icon (red). 

 

NOTE:  Ensure Excel files to be imported are closed before beginning the data import to 

Access. 

4.4. Click External Data in the menu bar at the top of the screen. See figure 4.3 (below). 

4.5. Click New Data Source in the External Data menu. See figure 4.3 (below). 

4.6. Hover over From File in the New Data Source dropdown menu. See figure 4.3 

(below). 

4.7. Hover over and select Excel in the From File dropdown menu. See figure 4.3. 

Figure 4.3. External Data/New Data Source/From File/Excel menu selections. 
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NOTE: Usually the file(s) to be imported will be formatted for Excel but they could be text file(s) 

or formatted other ways as necessary. 

4.8. After Excel is selected from the New Data Source menu the Get External Data - 

Excel Spreadsheet dialog box opens. See figure 4.4 (below). 

4.9. Click the Browse button near the top of the Get External Data - Excel Spreadsheet 

dialog box. See figure 4.4. 

Figure 4.4. Browse button in the Get External Data – Excel Spreadsheet dialog box. 
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4.10. After Browse is clicked in the Get External Data – Excel Spreadsheet the Windows 

File Open dialog box is displayed. See figure 4.5. 

Figure 4.5. Windows File Open dialog box. 
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4.11. Navigate to the location in which the report files to be imported are stored. See figure 

4.6 (below). 

4.12. Select the file to be imported. See figure 4.6 (below). 

4.13. Click Open to import the report file to Access. See figure 4.6. 

Figure 4.6. File selected and Open in the Windows File Open dialog box. 
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4.14. After Open is clicked in the Windows File Open dialog box the Get External Data – 

Excel Spreadsheet dialog box is displayed. See figure 4.7 (below). 

NOTE: Do not change the settings under the Search for “import” section of the dialog box 

when selecting the second file to be imported. The default setting of Import the source data into 

a new table in the current database is the correct setting. See figure .7 (below). 

4.15. Click OK in the lower right corner of the Get External Data - Excel Spreadsheet 

dialog box. See figure 4.7. 

Figure 4.7. The Get External Data – Excel Spreadsheet dialog box with File Name, Import Settings, and OK button 

highlighted. 
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4.16. After OK is clicked in the Get External Data – Excel Spreadsheet dialog box the 

first (worksheet/range) Import Spreadsheet Wizard dialog box is displayed. See 

figure 4.8 (below). 

4.17. In the first Import Spreadsheet Wizard dialog box the radio button next to Show 

Worksheets is selected by default. See figure 4.8 (below). 

4.18. Click Next in the lower right corner of the first (worksheet/range) Import 

Spreadsheet Wizard dialog box. See figure 4.8. 

Figure 4.8. The first dialog box of the Import Spreadsheet Wizard with Show Worksheets and Next highlighted. 
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4.19. After Next is clicked in the first (worksheet/range) Import Spreadsheet Wizard 

dialog box the second (column headings) Import Spreadsheet Wizard dialog box is 

displayed. See figure 4.9 (below). 

4.20. In the second Import Spreadsheet Wizard dialog box the check box next to First 

Row Contains Column Headings is checked by default. If it is not checked, click 

the checkbox next to First Row Contains Column Headings to select it. See figure 

4.9 (below). 

4.21. Click Next in the lower right corner of the second (column headings) Import 

Spreadsheet Wizard dialog box. See figure 4.9. 

Figure 4.9. First Row Contains Column Headings checkbox and Next highlighted in the second Import Spreadsheet 

Wizard dialog box. 
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4.22. After Next is clicked in the second (column headings) Import Spreadsheet Wizard 

dialog box the third (field options) Import Spreadsheet Wizard dialog box is 

displayed. See figure 4.10. 

Figure 4.10. Field Options in the third Import Spreadsheet Wizard dialog box. 
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NOTE:  Field Name, Indexed, and do not import field (Skip) do not normally require changes 

from their default settings. 

4.23. Click the title at the top of each displayed data column to view its data type to verify 

the Data Type in each data column is in Short Text (or) Date with Time format. For 

any data column indicating the Data Type is in Double format, select the column and 

change the data type to Short Text where necessary by clicking the down caret next 

to the Data Type selection box and selecting Short Text from the Data Type 

dropdown menu. See figure 4.11 (below). 

NOTE:  Usually only one or two of the displayed columns require these data type changes. 

4.24. When data type verification is complete click Next in the lower right corner of the 

third (field options) Import Spreadsheet Wizard dialog box. See figure 4.11. 

Figure 4.11. Data Type data selection of (Double to be corrected with Short Text) box and Next in the Field Options 

section of the third Import Spreadsheet Wizard dialog box. 
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4.25. After Next is clicked in the third (field options) Import Spreadsheet Wizard dialog 

box the fourth (primary ley) Import Spreadsheet Wizard dialog box is displayed. 

See figure 4.12 (below). 

4.26. In fourth Import Spreadsheet Wizard dialog box the radio button next to Let Access 

add primary key is usually selected by default. If it is not selected, click the radio 

button next to Let Access add primary key to select it. See figure 4.12 (below). 

4.27. Click Next in the lower right corner of the fourth (primary key) Import Spreadsheet 

Wizard dialog box. See figure 4.12. 

Figure 4.12. Let Access Add Primary Key selection and Next in the fourth Import Spreadsheet Wizard dialog box. 
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4.28. After Next is clicked in the fourth (primary key) Import Spreadsheet Wizard dialog 

box the fifth (save and finish) Import Spreadsheet Wizard dialog box is displayed. 

See figure 4.13 (below). 

4.29. Enter a file name in the Import to Table data entry field under Import to Table. See 

figure 4.13 (below). 

NOTE:  The name of the file from which the data was pulled can be used as the file name. 

NOTE:  Do not click the check box next to I would like a wizard to analyze my data after 

importing the data. See figure 4.13 (below). 

4.30. After the file name is entered click Finish in the lower right corner of the fifth (save 

and finish) Import Spreadsheet Wizard dialog box. See figure 4.13. 

Figure 4.13. The File name data entry field, the I would like a wizard to analyze my table after importing the data 

checkbox, and Next highlighted in the fifth Import Spreadsheet Wizard dialog box. 
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4.31. After Finish is clicked in the fifth (save and finish) Import Spreadsheet Wizard 

dialog box the Import Spreadsheet Wizard is closed and the Get External Data – 

Excel Spreadsheet dialog box is displayed. See figure 4.14 (below). 

NOTE: Do not click Save Import Steps in this screen of the Get External Data – Excel 

Spreadsheet dialog box. See figure .14 (below). 

4.32. Click Close in the lower right corner of the Get External Data – Excel Spreadsheet. 

See figure 4.14. 

Figure 4.14. The Save import steps and Close button highlighted in the Get External Data – Excel Spreadsheet dialog 

box. 
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4.33. After Close is clicked in the Get External Data – Excel Spreadsheet dialog box the 

first imported table is now listed under All Access Objects on the left side of the 

screen. See figure 4.15. 

Figure 4.15. The first imported table under All Access Objects.  
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4.34. Repeat steps 4.4 through 4.33 to import the other data file to Access. 

IMPORTANT: The exact sequence of steps may change when adding a second (or 

subsequent) tables. Follow the procedures outlined in steps X through Y for each dialog 

box that appears in the Get External Data – Excel Spreadsheet Wizard. 

NOTE: Do not change the settings under the Search for “import” section of the dialog box 

when selecting the second file to be imported. The default setting of Import the source data into 

a new table in the current database is the correct setting. See figure 4.16. 

Figure 4.16. Import options in the Get External Data – Excel Spreadsheet dialog box. 
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4.35. When importation of the second (or subsequent) table(s) is complete the imported 

data tables are listed under Tables in All Access Objects on the left side of the 

screen. See figure 3.17. 

Figure 4.17. Tables listed under All Access Objects. 
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NOTE: If an error is made during the external data import process a Data Map ImportErrors 

file will appear in the Tables list under All Access Objects on the left side of the workspace. 

This usually occurs when the data type imported to the table was not changed from Double to 

Short Text where required. To repair the problem the data import that generated the Data Map 

ImportErrors file (usually the most recent import) will need to be performed again. See figure 

4.18. 

Figure 4.18. Import Errors file under All Access Objects. 
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4.36. After correctly importing the data the Data Map ImportErrors file and the Table file 

in which the error(s) occurred (in this example FIP RTI Surgical) must be deleted 

from the All Access Objects list by right clicking on the file(s) and selecting Delete 

from the Table dropdown menus. See figure 4.19 (below). 

NOTE: Any Table or Query can be deleted from the All Access Objects list using the same 

deletion procedure. See figure 4.19. 

Figure 4.19. Deletion of the Import Errors file. 



FOUNDATION IP FILE COMPARISON PROCEDURE- DRAFT 09032019  

20 
 

 

4.37. Right click on one of the two tables (in this example CPA) listed in the All Access 

Objects list on the left side of the screen and select Design View from the Table 

dropdown menu. See figure 4.20. 

Figure 4.20. Design View in the Table dropdown file menu. 
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4.38. After clicking Design View in the Table dropdown menu the Design View dialog box 

is displayed. See figure 4.21 (below). 

4.39. In the Field Name column insert the name of the table being designed in front of the 

first data field name displayed in the Design View dialog box. Example- previous ID, 

new CPA-ID. See figure 4.21. 

Figure 4.21. CPA prefix inserted in front of the default field name on the first line in Design View. 
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4.40. Add the name of the table being designed in front of the remaining data field names 

displayed in the Design View dialog box. See figure 4.22 (below). 

NOTE: click CRTL+C to copy the added characters and CTRL+V to paste them into the 

remaining fields. See figure 4.22. 

Figure 4.22. CPA prefix inserted in front of the default field name on all lines in Design View. 
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NOTE:  The information pasted into the Field Name labels in front of the imported field names 

is only meant to differentiate the source of the data. FIP and CPA are often but not always used 

as the prefixes. 

4.41. When the field name edits are complete click File in the Access menu bar at the top 

of the page. See figure 4.23. 

Figure 4.23. File in the Access menu Bar. 
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4.42. After File is clicked the Info screen is displayed. See figure 4.24 (below). 

4.43. Click Save in the Info screen. See figure 4.24. 

Figure 4.24. The Info screen with Save highlighted. 

 

 

4.44. Click on the other table listed under Tables in the All Access Objects list on the left 

side of the screen. See figure 4.25 (below). 
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4.45. Repeat steps 4.37 through 4.43 to process the second (and any subsequent) 

table(s). See figures 4.26 and 4.27. 

Figure 4.26. FIP_RTI Surgical table about to be designed. 

 

Figure 4.27. FIP_RTI Surgical table with FIP- prefixes added. 
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4.46. After the table(s) have been created in Access capture the number of records 

displayed in the lower left corner of each table. See figure 4.28. 

Figures 4.28. Record totals highlighted. 

 

 

4.47. Export the data extracted from each table to separate tabs in an Excel spreadsheet 

file using the procedure outlined in the Exporting Access Query Data to MS Excel 

section (Section 10) (below). 

Back to section start 
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Back to top 

5. Finding Matched Records Using Queries in MS Access 

5.1. Click Create in the Access menu bar. See figure (below). 

5.2. Select Query Design from the Create menu. See figure 5.1. 

Figure 5.1. Create / Query Design in the Create menu bar. 

 

5.3. The Show Table dialog box is displayed. See figure 5.2 (below). 

5.4. Click the first table to be used (in this example CPA) listed in the Show Table dialog 

box. See figure 5.2 (below). 

5.5. Click Add at the bottom of the Show Table dialog box to add the selected table to 

the query. See figure 5.2 (below). 

5.6. After clicking Add in the Show Table dialog box the added table now appears in the 

Query1 workspace. See figure 5.2 (below). 

5.7. Click the the other table to be used (in this example FIP) listed in the Show Table 

dialog box. See figure 5.2 (below). 

5.8. Click Add at the bottom of the Show Table dialog box to add the table to the Query1 

workspace. See figure 5.2. 

Figure 5.2. Second table and Add highlighted in the Show Table dialog box. 
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5.9. After clicking Add in the Show Table dialog box both tables now appear in the 

Query1 design. See figure 5.3 (below). 

5.10. Click Close in the Show Table dialog box. See figure 5.3. 

Figure 5.3. Close highlighted in the Show Table dialog box. 
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5.11. After clicking Close in the Show Table dialog box the Show Table dialog box is 

closed leaving the tables listed in the Query1 display. See figure 5.4 (below). 

5.12. Click and drag the borders of each table in the Query1 workspace to resize each 

of them to enable viewing of all data entries in each table. See figure 5.4. 

Figure 5.4. Both tables resized for effective viewing of the fields therein. 
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5.13. Double click each field entry in the following order to add them to the query: 

5.13.1. CPA-ID 

5.13.2. FIP-ID 

5.13.3. CPA-Client’s Case Code 

5.13.4. FIP-Matter FIP ID 

5.13.5. CPA-CPA Case Status 

5.13.6. FIP-STATUS 

5.13.7. CPA-Client account number 

5.13.8. CPA-File Number 

5.13.9. FIP-FILE NUMBER 

5.13.10. CPA-Patent / Design Number 

5.13.11. FIP-PATENT NUMBER 

5.13.12. CPA-Application number 

5.13.13. FIP-APPLICATION NUMBER 

5.13.14. FIP-ANNUITY PAYMENT PROVIDER 

5.13.15. FIP-CPA GLOBAL 

5.13.16. CPA-Country name 

5.13.17. FIP-COUNTRY 

NOTE: As each field is added it appears in the table at the bottom of the Query. See figure 5.5. 

Figure 5.5. Tables with selected fields (split screen capture- the table is wider than can be viewed here.) 
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NOTE: The design of the query will depend on the data needed in the output file. Not all fields 

are used for every output file. 

NOTE: FIP to CPA correlations are FIP ID to CPA Case Code, FIP Patent Number to CPA 

Patent Design Number, and FIP Matter ID to CPA Client Case Code. 

5.14. Left click CPA-Client’s Case Code in the CPA column and drag it to FIP-MATTER 

FIP ID in the FIP column then release the mouse button to link the two data fields. 

See figure 5.6 (below). 

NOTE: If the association between CPA-Client’s Case Code and FIP-MATTER FIP ID is not 

made, when run the query will yield a virtual mountain of unusable spurious data. 

Figure 5.6. Client’s Case Code linked to FIP-FIP MATTER ID and Run highlighted in the menu bar. 



FOUNDATION IP FILE COMPARISON PROCEDURE- DRAFT 09032019  

32 
 

 

5.15. Click Run from the Design tab in the menu bar. See figure 5.6 (above). 

NOTE: The Run command can be executed multiple times after data is added (or) removed 

from tables.  

5.16. After Run is clicked the Query is run by Access and the resulting data is displayed in 

a Query1 tab. See figure 5.7. 

Figure 5.7. Query results displayed. 
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5.17. Save Query1 by right clicking the Query1 tab in the leftmost corner of the query data 

display. See figure 5.8 (below). 

5.18. After the Query 1 tab is right clicked the Save dropdown menu is displayed. See 

figure 5.8 (below). 

5.19. Click Save in the Save dropdown menu. See figure 5.8. 

Figure 5.8. Save in the Save As dialog box. 
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5.20. After Save is clicked in the Save dropdown menu the Save As dialog box is 

displayed. See figure 5.9 (below). 

5.21. In the Save As dialog box enter a descriptive file name in the Query Name data 

entry field. See figure 5.9 (below). 

5.22. After entering the descriptive file name in the Query Name data entry field click OK 

in the Save As dialog box to save the Query. See figure 5.9. 

Figure 5.9. Save Changes dialog box with Yes highlighted. 
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5.23. After clicking OK in the Save As dialog box the newly created query is listed under 

the All Access Objects list on the leftmost side of the page (and) the name 

displayed in the tab is also changed to the entered file name. See figure 5.10. 

Figure 5.10. New query listed in All Access Objects. 

 

 

5.24. Scroll down and capture the number of records displayed in the lower left corner of 

the Matches query data display See figure 5.11. 

Figures 5.11. Record totals highlighted. 

 

5.25. Compare the number of records in the Matches query data display to the total 

number of records in each table data display. See figure 5.12. 

NOTE:  The number of matches should not exceed the lower matter number. If it does, that is a 
clear sign that there are duplicates which would be pointed out//made known when running the 
duplicate matches query. 
 

Figures 5.12. Record totals highlighted 
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5.26. Export the data generated by the query to a separate tab in an Excel spreadsheet file 

using the procedure outlined in the Exporting Access Query Data to MS Excel 

section (Section 10) (below). 

Back to section start 

Back to top 

 

6. Finding Duplicate Records Using Primary Key CPA ID and Matches Query 

in MS Access 

6.1. Click Create in the Access menu bar at the top of the page. See figure 6.1 (below). 

6.2. Click Query Wizard in the Create menu. See figure 6.1. 

Figure 6.1. Query Wizard in the Create menu. 

 

6.3. After clicking Query Wizard in the Create menu the New Query dialog box is 

displayed. See figure 6.2 (below). 

NOTE:  The New Query dialog box defaults to the Simple Query Wizard selected. It will be 

necessary to change this selection. See figure 6.2. 
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Figure 6.2. New Query dialog box. 

 

 

6.4. In the New Query dialog box click Find Duplicates Query Wizard. See figure 6.3 

(below). 

6.5. Click OK at the bottom of the New Query dialog box. See figure 6.3. 

Figure 6.3. Find Duplicates Query Wizard and Next highlighted in the New Query dialog box. 
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6.6. After OK is clicked in the New Query dialog box the New Query dialog box is closed 

and the first (table selection) Find Duplicates Query Wizard dialog box is displayed. 

See figure 6.4. 

Figure 6.4. Table selection in the Find Duplicates Query Wizard. 

 

6.7. Click the Queries radio button in the View menu of the Find Duplicates Query 

Wizard dialog box. See figure 6.5 (below). 

Figure 6.5. Queries radio button in the Find Duplicates Query Wizard. 
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6.8. After the Queries radio button is clicked the Find Duplicates Query Wizard dialog 

box displays a list of available queries from which to choose. See figure 6.6 (below). 

6.9. If it is not already highlighted for selection, double click the Matches query. See 

figure 6.6 (below). 

6.10. Click Next in the lower right corner of the first (table selection) Find Duplicates 

Query Wizard dialog box. See figure 6.6. 

Figure 6.6. Selections and Next highlighted in the Find Duplicates Query Wizard. 
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6.11. After Next is clicked in the first (table selection) Find Duplicates Query Wizard 

dialog box the second (duplicate-value fields) Find Duplicates Query Wizard dialog 

box is displayed. See figure 6.7. 

Figure 6.7. Duplicate fields in the Find Duplicates Query Wizard. 
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6.12. If it is not already highlighted for selection, click CPA-ID in the Available fields list 

on the left side of the dialog box. See figure 6.8 (below). 

6.13. Click the add icon (>)  to add the selected Available field (in this example CPA-

Client’s Case Code) to the Duplicate-value fields list on the right side of the dialog 

box. See figure 6.8 (below). 

NOTE: A maximum of 10 (ten) fields can be added to the Duplicate-value fields list. 

NOTE: Do NOT click the add all icon (>>) to add all available fields to the Duplicate-value fields 

list. 

6.14. After the desired field is added to the Duplicate-value fields list click Next at the 

bottom of the second (duplicate-value fields) Find Duplicates Query Wizard dialog 

box. See figure 6.8. 

Figure 6.8. Selections and Next highlighted in the Duplicate fields Find Duplicates Query Wizard dialog box. 
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6.15. After Next is clicked in the second (duplicate-value fields) Find Duplicates Query 

Wizard dialog box the third (additional query fields) of the Find Duplicates Query 

Wizard dialog box is displayed. See figure 6.9. 

Figure 6.9. Additional fields in the Find Duplicates Query Wizard. 
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6.16. Click the add all icon (>>)  to add all available fields to the Additional query fields 

list on the right side of the third Find Duplicates Query Wizard dialog box. See 

figure 6.10 (below). 

6.17. After clicking the add all icon (>>)  the Additional query fields are populated with all 

available fields previously listed on the left side (available fields) of the Find 

Duplicates Query Wizard dialog box. See figure 6.10 (below). 

6.18. Click Next at the bottom of the third (additional query fields) Find Duplicates Query 

Wizard dialog box. See figure 6.10. 

Figure 6.10. Selections and Next highlighted in the Additional fields Find Duplicates Query Wizard Dialog box. 
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6.19. After Next is clicked in the third (additional query fields) Find Duplicates Query 

Wizard dialog box the fourth (name and save) Find Duplicates Query Wizard 

dialog box is displayed. See figure 6.11. 

Figure 6.11. Name and save in the Find Duplicates Query Wizard. 
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6.20. Click in the data entry field to name the Query as Duplicates between the table 

source(s). Example: CPA ID Duplicates. See figure 6.12 (below). 

NOTE: The radio button next to View the results should be selected by default. If it is not 

already selected click the radio button next to View the results to select it. See figure 6.12 

(below). 

6.21. Click Finish at the bottom of the fourth (name and save) Find Duplicates Query 

Wizard dialog box. See figure 6.12. 

Figure 6.12. Selections and Finish in the name and save Find Duplicates Query Wizard dialog box. 
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6.22. After Finish is clicked in fourth (name and save) Find Duplicates Query Wizard 

dialog box the wizard is closed and the newly generated query is displayed on the 

left under All Access Objects- Queries. See figure 6.13. 

Figure 6.13. Newly created Duplicates query listed in All Access Objects. 

 

6.23. The query usually generates data indicating no duplicates were found (no records 

listed in the results data). See figure 6.14. 

Figure 6.14. No duplicate records found in the new query. 



FOUNDATION IP FILE COMPARISON PROCEDURE- DRAFT 09032019  

47 
 

 

6.24. If any duplicates are found export the data generated by the query to a separate tab 

in an Excel spreadsheet file using the procedure outlined in the Exporting Access 

Query Data to MS Excel section (Section 10) (below). 

NOTE: The expected result is no duplicates were found. Any duplicates revealed during this 

research must be investigated. 

Back to section start 

Back to top 

 

7. Finding Duplicate Records Using Primary Key FIP ID and Matches Query in 

MS Access 

7.1. Click Create in the Access menu bar at the top of the page. See figure 7.1 (below). 

7.2. Click Query Wizard in the Create menu. See figure 7.1. 

Figure 7.1. Query Wizard in the Create menu. 
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7.3. After clicking Query Wizard in the Create menu the New Query dialog box is 

displayed. See figure 7.2 (below). 

NOTE:  The New Query dialog box defaults to the Simple Query Wizard selected. It will be 

necessary to change this selection. See figure 7.2. 

Figure 7.2. New Query dialog box. 

 

 

7.4. In the New Query dialog box click Find Duplicates Query Wizard. See figure 7.3 

(below). 
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7.5. Click OK at the bottom of the New Query dialog box. See figure 7.3. 

Figure 7.3. Find Duplicates Query Wizard and Next highlighted in the New Query dialog box. 

 

7.6. After OK is clicked in the New Query dialog box the New Query dialog box is closed 

and the first (table selection) Find Duplicates Query Wizard dialog box is displayed. 

See figure 7.4. 

Figure 7.4. Table selection in the Find Duplicates Query Wizard. 

 

7.7. Click the Queries radio button in the View menu of the Find Duplicates Query 

Wizard dialog box. See figure 7.5. 

Figure 7.5. Queries radio button in the Find Duplicates Query Wizard. 
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7.8. After the Queries radio button is clicked the Find Duplicates Query Wizard dialog 

box displays a list of available queries from which to choose. See figure 7.6 (below). 

7.9. If it is not already highlighted for selection, double click the Matches query. See 

figure 7.6 (below). 

7.10. Click Next in the lower right corner of the first (table selection) Find Duplicates 

Query Wizard dialog box. See figure 7.6. 

Figure 7.6. Selections and Next highlighted in the Find Duplicates Query Wizard. 
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7.11. After Next is clicked in the first (table selection) Find Duplicates Query Wizard 

dialog box the second (duplicate-value fields) Find Duplicates Query Wizard dialog 

box is displayed. See figure 7.7. 

Figure 7.7. Duplicate fields in the Find Duplicates Query Wizard. 
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7.12. If it not already highlighted for selection, click FIP-ID in the Available fields list on 

the left side of the dialog box. See figure 7.8 (below). 

7.13. Click the add icon (>)  to add the selected Available field (in this example CPA-

Client’s Case Code) to the Duplicate-value fields list on the right side of the dialog 

box. See figure 7.8 (below). 

NOTE: A maximum of 10 (ten) fields can be added to the Duplicate-value fields list. 

NOTE: Do not click the add all icon (>>) to add all available fields to the Duplicate-value fields 

list. 

7.14. After the desired field is added to the Duplicate-value fields list click Next at the 

bottom of the second (duplicate-value fields) Find Duplicates Query Wizard dialog 

box. See figure 7.8. 

Figure 7.8. Selections and Next highlighted in the Duplicate fields Find Duplicates Query Wizard dialog box. 
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7.15. After Next is clicked in the second (duplicate-value fields) Find Duplicates Query 

Wizard dialog box the third (additional query fields) of the Find Duplicates Query 

Wizard dialog box is displayed. See figure 7.9. 

Figure 7.9. Additional fields in the Find Duplicates Query Wizard.  
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7.16. Click the add all icon (>>)  to add all available fields to the Additional query fields 

list on the right side of the third Find Duplicates Query Wizard dialog box. See 

figure 7.10 (below). 

7.17. After clicking the add all icon (>>)  the Additional query fields are populated with all 

available fields previously listed on the left side (available fields) of the dialog box. 

See figure 7.10 (below). 

7.18. Click Next at the bottom of the third (additional query fields) Find Duplicates Query 

Wizard dialog box. See figure 7.10. 

Figure 7.10. Selections and Next highlighted in the Additional fields Find Duplicates Query Wizard Dialog box. 
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7.19. After Next is clicked in the third (additional query fields) Find Duplicates Query 

Wizard dialog box the fourth (name and save) Find Duplicates Query Wizard 

dialog box is displayed. See figure 7.11. 

Figure 7.11. Name and save in the Find Duplicates Query Wizard. 
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7.20. Click in the data entry field to name the Query as Duplicates between the table 

source(s). Example: FIP ID Duplicates. See figure 7.12 (below). 

NOTE: The radio button next to View the results should be selected by default. If it is not 

already selected click the radio button next to View the results to select it. See figure 7.12 

(below). 

7.21. Click Finish at the bottom of the fourth (name and save) Find Duplicates Query 

Wizard dialog box. See figure 7.12. 

Figure 7.12. Selections and Finish in the name and save Find Duplicates Query Wizard dialog box. 
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7.22. After Finish is clicked in fourth (name and save) Find Duplicates Query Wizard 

dialog box the wizard is closed and the newly generated query is displayed on the 

left under All Access Objects- Queries. See figure 7.13. 

Figure 7.13. Newly created Duplicates query listed in All Access Objects. 

 

7.23. The query usually generates data indicating no duplicates were found (no records 

listed in the results data). See figure 7.14. 

Figure 7.14. No duplicate records found in the new query. 
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7.24. If any duplicates are found export the data generated by the query to a separate tab 

in an Excel spreadsheet file using the procedure outlined in the Exporting Access 

Query Data to MS Excel section (Section 10) (below). 

NOTE: The expected result is no duplicates were found. Any duplicates revealed during this 

research must be investigated. 

Back to section start 

Back to top 

 

8. Finding Unmatched Records Between CPA Table and Matches Query in MS 

Access 

8.1. Click Create in the menu bar at the top of the page. See figure 8.1 (below). 

8.2. Click Query Wizard in the Create menu. See figure 8.1. 

Figure 8.1. Query Wizard in the Create menu. 
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8.3. After Query Wizard is clicked in the Create menu the New Query dialog box is 

displayed. See figure 8.2 (below). 

NOTE:  The New Query dialog box defaults to the Simple Query Wizard selected. It will be 

necessary to change this selection. See figure 8.2. 

Figure 8.2. New Query dialog box. 
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8.4. In the New Query dialog box click Find Unmatched Query Wizard. See figure 8.3 

(below) 

8.5. Click OK at the bottom of the New Query dialog box. See figure 8.3. 

Figure 8.3. Find Unmatched and OK highlighted in the New Query Wizard dialog box. 

 

8.6. After OK is clicked in the New Query dialog box the New Query dialog box is closed 

and the first (table/query selection) Find Unmatched Query Wizard dialog box is 

displayed. See figure 8.4. 

Figure 8.4. Table selection in the Find Unmatched Query Wizard dialog box. 
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8.7. Double click the table name containing the data to be compared in this Query. See 

figure 8.5 (below). 

NOTE:  The radio button next to Tables in the View section of the Find Unmatched Query 

Wizard should be checked by default. If it is not checked, click the radio button next to Tables 

to select it. See figure 8.5 (below). 

Do not click Next until the following steps (8.8 through 8.10) are complete. See figure 8.5. 

Figure 8.5. Selections in the table selection Find Unmatched Query Wizard dialog box. 
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8.8. After selecting the Table for the query, click the Queries radio button in the View 

section under the list of tables in the Find Unmatched Query Wizard dialog box. 

See figure 8.6 (below). 

NOTE: When repeating these steps for subsequent queries it is important to ensure that the 

correct original query is selected. See figure 8.6. 

Figure 8.6. Queries radio button in the Find Unmatched Query Wizard dialog box  
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8.9. After clicking the Queries radio button the Find Unmatched Query Wizard dialog 

box displays a list of available queries from which to choose (and) the Queries radio 

button is highlighted. See figure 8.7 

Figure 8.7. Available queries list. 
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8.10. If it not already highlighted for selection, double click the query name containing the 

related records to this query (Matches). See figure 8.8 (below). 

8.11. After selection of the query containing related records is complete click Next at the 

bottom of the second Find Unmatched Query Wizard dialog box. See figure 8.8. 

Figure 8.8. Selections and Next highlighted in the related records Find Unmatched Query Wizard dialog box 
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8.12. After Next is clicked in the second (related records) Find Unmatched Query Wizard 

dialog box the third (duplicate fields) Find Unmatched Query Wizard dialog box is 

displayed. See figure 8.9. 

Figure 8.9. Duplicate fields Find Unmatched Query Wizard dialog box. 
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8.13. Click CPA-ID in the left Fields column. See figure 8.10 (below). 

8.14. Click CPA-ID in the right Fields column. See figure 8.10 (below). 

NOTE: The variables for CPA-Client’s Case Code (or) FIP-FIP MATTER ID may appear in 

either table depending upon the query being created. 

8.15. Click the match fields (<=>) icon between the two Fields lists. See figure 8.10 

(below). 

8.16. After clicking the match fields icon (<=>) the matching fields are displayed in the 

Matching Fields data display box under the Fields listings. See figure 8.10 (below). 

8.17. Click Next at the bottom of the third (duplicate fields) Find Unmatched Query 

Wizard dialog box. See figure 8.10. 

Figure 8.10. Selections and Next highlighted in the duplicate fields Find Unmatched Query Wizard dialog box 
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8.18. After clicking Next in the third (duplicate fields) Find Unmatched Query Wizard 

dialog box the fourth (visible fields) Find Unmatched Query Wizard dialog box is 

displayed. See figure 8.11. 

Figure 8.11. Visible fields Find Unmatched Query Wizard dialog box. 
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8.19. Click the Add All icon (>>) to add all available fields to the query. See figure 8.12 

(below). 

8.20. After clicking the Add All icon (>>) all available fields are now displayed in the 

Selected Fields column of the fourth Find Unmatched Query Wizard dialog box. 

See figure 8.12 (below) 

8.21. Click Next at the bottom of the fourth (visible fields) Find Unmatched Query Wizard 

dialog box. See figure 8.12. 

Figure 8.12. Selections and Next highlighted in the visible fields Find Unmatched Query Wizard dialog box. 
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8.22. After Next is clicked in the fourth (visible fields) Find Unmatched Query Wizard 

dialog box the fifth (save and finish) Find Unmatched Query Wizard dialog box is 

displayed See figure 8.13. 

Figure 8.13. Save and finish Find Unmatched Query Wizard dialog box. 
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8.23. Click in the data entry field under What would you like to name your query? to 

name the query for the fields used in creation of the Query- Example: Unmatched 

from CPA (or) Unmatched from FIP. See figure 8.14 (below). 

NOTE: The query name should include any tables or queries used in its generation. 

NOTE: The radio button next to View the results should be selected by default. If it is not 

already selected click the radio button next to View the results to select it. See figure 8.14 

(below). 

8.24. Click Finish at the bottom of the fifth (save and finish) Find Unmatched Query 

Wizard dialog box. See figure 8.14. 

Figure 8.14. Selections and Finish highlighted in the save and finish Find Unmatched Query Wizard dialog box. 

 

8.25. After Finish is clicked in the fifth (save and finish) Find Unmatched Query Wizard 

dialog box the wizard is closed. 

8.26. The newly generated Query is displayed on the left under All Access Objects- 

Queries (and) the name of the query is updated on its workspace tab. See figure 

8.15. 

Figure 8.15. Newly created Unmatched query listed in All Access Objects. 
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8.27. The number of records displayed in the Unmatched query should match the 

difference between the sources of the query data- example the difference between 

matches and the CPA-derived table. The number of records in the Unmatched query 

should equal the difference between the Matches query and each table. In the case 

of this example the difference between 1943 records and 1911 records was 32 

records. See figure 8.16. 

Figure 8.16. Record total highlighted. 

 

8.28. Export the data to generated by the query to a separate tab in an Excel spreadsheet 

file using the procedure outlined in the Exporting Access Query Data to MS Excel 

section (Section 10) (below). 

Back to section start 

Back to top 

 

9. Finding Unmatched Records Between FIP Table and Matches Query in MS 

Access 

9.1. Click Create in the menu bar at the top of the page. See figure 9.1 (below). 

9.2. Click Query Wizard in the Create menu. See figure 9.1. 

Figure 9.1. Query Wizard in the Create menu. 



FOUNDATION IP FILE COMPARISON PROCEDURE- DRAFT 09032019  

72 
 

 

 

9.3. After Query Wizard is clicked in the Create menu the New Query dialog box is 

displayed. See figure 9.2 (below). 

NOTE:  The New Query dialog box defaults to the Simple Query Wizard selected. It will be 

necessary to change this selection. See figure 9.2. 

Figure 9.2. New Query dialog box. 
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9.4. In the New Query dialog box click Find Unmatched Query Wizard. See figure 9.3 

(below) 

9.5. Click OK at the bottom of the New Query dialog box. See figure 9.3. 

Figure 9.3. Find Unmatched and OK highlighted in the New Query Wizard dialog box. 

 

9.6. After OK is clicked in the New Query dialog box the New Query dialog box is closed 

and the first (table/query selection) Find Unmatched Query Wizard dialog box is 

displayed. See figure 9.4. 
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Figure 9.4. Table selection in the Find Unmatched Query Wizard dialog box. 

 

9.7. Double click the table name containing the data to be compared in this Query. See 

figure 9.5 (below). 

NOTE:  The radio button next to Tables in the View section of the Find Unmatched Query 

Wizard should be checked by default. If it is not checked, click the radio button next to Tables 

to select it. See figure 9.5 (below). 

Do not click Next until the following steps (9.8 through 9.10) are complete. See figure 9.5. 

Figure 9.5. Selections in the table selection Find Unmatched Query Wizard dialog box. 
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9.8. After selecting the Table for the query, click the Queries radio button in the View 

section under the list of tables in the Find Unmatched Query Wizard dialog box. 

See figure 9.6 (below). 

NOTE: When repeating these steps for subsequent queries it is important to ensure that the 

correct original query is selected. 

Figure 9.6. Queries radio button in the Find Unmatched Query Wizard dialog box  
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9.9. After clicking the Queries radio button the Find Unmatched Query Wizard dialog 

box displays a list of available queries from which to choose (and) the Queries radio 

button is highlighted. See figure 9.7 

Figure 9.7. Available queries list. 
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9.10. If it is not already highlighted for selection, double click the query name containing 

the related records to this query (Matches). See figure 9.8 (below). 

9.11. After selection of the query containing related records is complete click Next at the 

bottom of the second Find Unmatched Query Wizard dialog box. See figure 9.8. 

Figure 9.8. Selections and Next highlighted in the related records Find Unmatched Query Wizard dialog box 
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9.12. After Next is clicked in the second (related records) Find Unmatched Query Wizard 

dialog box the third (duplicate fields) Find Unmatched Query Wizard dialog box is 

displayed. See figure 9.9. 

Figure 9.9. Duplicate fields Find Unmatched Query Wizard dialog box. 

 



FOUNDATION IP FILE COMPARISON PROCEDURE- DRAFT 09032019  

79 
 

 

9.13. Click FIP-ID in the left Fields column. See figure 9.10 (below). 

9.14. Click FIP-ID in the right Fields column. See figure 9.10 (below). 

NOTE: The variables for CPA-Client’s Case Code (or) FIP-FIP MATTER ID may appear in 

either table depending upon the query being created. 

9.15. Click the match fields (<=>) icon between the two Fields lists. See figure 9.10 

(below). 

9.16. After clicking the match fields icon (<=>) the matching fields are displayed in the 

Matching Fields data display box under the Fields listings. See figure 9.10 (below). 

9.17. Click Next at the bottom of the third (duplicate fields) Find Unmatched Query 

Wizard dialog box. See figure 9.10. 

Figure 9.10. Selections and Next highlighted in the duplicate fields Find Unmatched Query Wizard dialog box 
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9.18. After clicking Next in the third (duplicate fields) Find Unmatched Query Wizard 

dialog box the fourth (visible fields) Find Unmatched Query Wizard dialog box is 

displayed. See figure 9.11. 

Figure 9.11. Visible fields Find Unmatched Query Wizard dialog box. 
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9.19. Click the Add All icon (>>) to add all available fields to the query. See figure 9.12 

(below). 

9.20. After clicking the Add All icon (>>) all available fields are now displayed in the 

Selected Fields column of the fourth Find Unmatched Query Wizard dialog box. 

See figure 9.12 (below) 

9.21. Click Next at the bottom of the fourth (visible fields) Find Unmatched Query Wizard 

dialog box. See figure 9.12. 

Figure 9.12. Selections and Next highlighted in the visible fields Find Unmatched Query Wizard dialog box. 
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9.22. After Next is clicked in the fourth (visible fields) Find Unmatched Query Wizard 

dialog box the fifth (save and finish) Find Unmatched Query Wizard dialog box is 

displayed See figure 9.13. 

Figure 9.13. Save and finish Find Unmatched Query Wizard dialog box. 
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9.23. Click in the data entry field under What would you like to name your query? to 

name the query for the fields used in creation of the Query- Example: Unmatched 

from CPA (or) Unmatched from FIP. See figure 9.14 (below). 

NOTE: The query name should include any tables or queries used in its generation. 

NOTE: The radio button next to View the results should be selected by default. If it is not 

already selected click the radio button next to View the results to select it. See figure 9.14 

(below). 

9.24. Click Finish at the bottom of the fifth (save and finish) Find Unmatched Query 

Wizard dialog box. See figure 9.14. 

Figure 9.14. Selections and Finish highlighted in the save and finish Find Unmatched Query Wizard dialog box. 

 

 

9.25. After Finish is clicked in the fifth (save and finish) Find Unmatched Query Wizard 

dialog box the wizard is closed. 

9.26. The newly generated Query is displayed on the left under All Access Objects- 

Queries (and) the name of the query is updated on its workspace tab. See figure 

9.15. 

Figure 9.15. Newly created Unmatched query listed in All Access Objects. 
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9.27. The number of records displayed in the Unmatched query should match the 

difference between the sources of the query data- example the difference between 

matches and the FIP-derived table. The number of records in the Unmatched query 

should equal the difference between the Matches query and each table. In the case 

of this example the difference between 1943 records and 1911 records was 32 

records. See figure 9.16. 

Figure .16. Record total highlighted. 

 

9.28. Export the data to generated by the query to a separate tab in an Excel spreadsheet 

file using the procedure outlined in the Exporting Access Query Data to MS Excel 

section (Section 10) (below). 

Back to section start 

Back to top 

 

10. Exporting Access Query Data to MS Excel 

10.1. Open MS Access. 

10.2. Open the table (or) query from which data is to be exported to Excel. 
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10.3. After the file is open click the upper left corner of the data field display. See figure 

10.1. 

Figure 10.1. Upper left corner of the Matches query data display. 

 

10.4. After the upper left corner of the data display is clicked all cells in the data field 

display turn blue. See figure 10.2. 

Figure 10.2.  Query results highlighted. 
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10.5. With the query results highlighted click CTRL + C to copy the selected data in the 

query. 

10.6. Open Excel. 

10.7. Click Blank Workbook in the Templates dialog box. See figure 10.3. 

NOTE: If Excel is already open or in use, select File and then New from the Excel menu bar at 

the top of the Excel screen. 

Figure 10.3. Blank Workbook in the Templates dialog box in Excel. 

 

10.8. After the blank workbook file is open click in cell A1 in the upper left corner of the 

screen. See figure 10.4. 

Figure 10.4. Cell A1 highlighted in Excel. 
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10.9. Click CRTL+V to copy the selected Access data to the Excel spreadsheet. 

10.10. After CTRL+V is clicked the data from Access is copied to the Excel spreadsheet. 

See figure 10.5. 

Figure 10.5. Data copied to the Excel spreadsheet. 

 

10.11. Click Data in the Menu bar. See figure 10.6 (below). 
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10.12. Select Filter in the Data menu to add data filtering options. See figure 10.6. 

Figure 10.6. Filter in the in the Excel Data menu. 

 

10.13. After Filter is selected in the Data menu, down carets are displayed in the column 

headers with filtering options listed in the column-specific dropdown menus. See 

figures 10.7 and 10.8 

Figure 10.7. Down carets next to column headings indicating filters have been added. 

 

Figure 10.8. Dropdown menu opened when down caret for filters is clicked. 



FOUNDATION IP FILE COMPARISON PROCEDURE- DRAFT 09032019  

89 
 

 

10.14. Click View in the Excel menu bar. See figure 10.9 (below). 

10.15. Select Freeze Panes in the View menu. See figure 10.9 (below). 

10.16. Select Freeze Top Row in the Freeze Panes dropdown menu. See figure 10.9. 

Figure 10.9. Freeze Panes/Freeze Top Row in the Excel View menu. 
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10.17. After Freeze Top Row is clicked in the Freeze Panes menu the top row of data (in 

this case the column headings row) remains visible while scrolling in the spreadsheet 

at all times. 

10.18. Click Home in the menu bar. See figure 10.10 (below). 

10.19. Click on the row header for row number 1 on the far left of the spreadsheet to select 

the top row of data. See figure 10.10. 

Figure 10.10. Row number one highlighted in Excel. 

 

10.20. In the Home menu select Wrap Text. See figure 10.11. 

Figure 10.11. Wrap Text highlighted in the Excel Home menu. 
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10.21. After Wrap Text is selected in the Home menu, row 1 is displayed with wrapped text. 

See figure 10.12. 

Figure 10.12. Row one with wrapped text in Excel. 

 

10.22. With row number 1 still selected, in the Home Menu select Bold. See figure 10.13. 

Figure 10.13. Bold highlighted in Excel. 
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10.23. After Bold is selected in the Home menu the text in row 1 is displayed in a bold font. 

See figure 10.14. 

Figure 10.14. Row one now in bold type in Excel. 

 

10.24. With row number 1 still selected, in the Home menu click the down caret next to Fill 

Colors (the small bucket icon). See figure 10.15 (below). 

10.25. After the down caret is clicked the Fill Colors - Theme Colors dialog box is 

displayed. See figure 10.15 (below). 

10.26. From the Fill Colors - Theme Colors menu select a light gray alternate fill color 

from the list of available colors. See figure 10.15. 

Figure 10.15. Fill colors in the Excel Home menu. 
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10.27. After the alternate color is selected the first row of data is shaded light gray. See 

figure 10.16. (below). 

10.28. Click the triangle in the upper left corner of the data display to select all cells in the 

spreadsheet. See figure 10.16. 

Figure 10.16. Select all corner highlighted in Excel. 

 

10.29. After clicking the triangle in the upper left corner all cells are selected in Excel. See 

figure 10.17. 

Figure 10.17. All cells selected in Excel. 
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10.30. With all cells selected, from the Home menu click the down caret next to Borders. 

See figure 10.18 (below). 

10.31. After the down caret is clicked the Borders dropdown menu is displayed. See figure 

10.18 (below). 

10.32. In the Borders dropdown menu click All Borders. See figure 10.18. 

Figure 10.18. Borders/All Borders highlighted in the Excel Home menu. 
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10.33. After All borders is clicked in the Borders dropdown menu the spreadsheet is 

displayed with borders around all cells. See figure 10.19 (below). 

NOTE:  Following steps 10.34 through 10.48 are optional. Displaying key data columns with 

a contrasting background can be beneficial when scrolling though large spreadsheets. 

10.34. Click the column header letters above the CPA Client’s Case Code and FIP- Matter 

ID columns (in this case columns C and D) to select all cells in those column(s). See 

figure 10.19. 

Figure 10.19. Column header letters highlighted in Excel. 
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10.35. With columns C and D still selected, in the Home menu click the down caret next to 

Fill Colors (the small bucket icon). See figure 10.20 (below). 

10.36. After the down caret is clicked the Fill Colors - Theme Colors dialog box is 

displayed. See figure 10.20 (below). 

10.37. From the Fill Colors - Theme Colors menu select yellow from the list of available 

colors. See figure 10.20 (below). 

10.38. After selection of the different fill color the cells in the selected column(s) are now 

filled with a different color (yellow in this case). See figure 10.20. 

Figure 10.20. Fill colors in the Excel Home menu. 
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10.39. Click the column header letters above the FIP Annuity Payment Provider and FIP-

CPA Global columns (in this case columns N and O) to select all cells in those 

column(s). See figure 10.21 (below). 

10.40. With columns N and O still selected, in the Home menu click the down caret next to 

Fill Colors (the small bucket icon). See figure 10.21 (below). 

10.41. After the down caret is clicked the Fill Colors - Theme Colors dialog box is 

displayed. See figure 10.21 (below). 

10.42. From the Fill Colors - Theme Colors menu select yellow from the list of available 

colors. See figure 10.21 (below). 

10.43. After selection of the different fill color the cells in the selected column(s) are now 

filled with a different color (yellow in this case). See figure 10.21. 

Figure 10.21. Fill colors selected in Excel. 
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10.44. Click the column header letters above the CPA Case Code and FIP Status columns 

(in this case columns E and F) to select all cells in those column(s). See figure 10.22 

(below). 

10.45. With columns F and F still selected, in the Home menu click the down caret next to 

Fill Colors (the small bucket icon). See figure 10.22 (below). 

10.46. After the down caret is clicked the Fill Colors - Theme Colors dialog box is 

displayed. See figure 10.22 (below). 

10.47. From the Fill Colors - Theme Colors menu select green from the list of available 

colors. See figure 10.22 (below). 

10.48. After selection of the different fill color the cells in the selected column(s) are now 

filled with a different color (green in this case). See figure 10.22. 

Figure 10.22. Fill colors selected in Excel. 
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10.49. Right click the column header letters above the FIP-ID and CPA-ID columns (in this 

case columns A and B) to select all cells in those column(s). See figure 10.23. 

Figure 10.23. Column header letters highlighted in Excel. 
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10.50. With columns A and B still selected right click to reveal the dropdown menu. See 

figure 10.24 (below). 

10.51. Select Delete from the dropdown menu to delete the CPA-ID and FIP-ID column(s) 

(in this case columns A and B) from the spreadsheet. See figure 10.24. 

Figure 10.24. Deleting columns in Excel. 
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10.52. Click the leftmost column header letter (column C in this example). See figure 10.25 

(below). 

10.53. Press the Shift key while clicking the rightmost column header letter (column P in 

this case). See figure 10.25 (below). 

10.54. After Shift+clicking the rightmost column header letter all columns in the 

spreadsheet are selected. See figure 10.25. 

Figure 10.25. All columns selected in Excel. 
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10.55. With the cursor in the selected cells, right click to reveal the Formatting dropdown 

menu. See figure 10.26 (below). 

10.56. In the Formatting dropdown menu click Column Width. See figure 10.26. 

Figure 10.26. Column Width highlighted in Excel formatting dropdown menu. 
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10.57. After Column Width is clicked in the Formatting dropdown menu the Column Width 

dialog box is displayed. See figure 10.27 (below). 

10.58. Enter 11 for the value in the Column Width data entry field. See figure 10.27 

(below). 

10.59. Click OK in the Column Width dialog box below the Column Width data entry field 

to complete the change. See figure 10.27. 

Figure 10.27. Setting column width to 11 in Excel column width dialog box. 
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10.60. After setting column width to increase readability in the spreadsheet the formatting of 

the data is complete. See figure 10.28 (below). 

RESULT: Spreadsheet data ready for investigation. 

Figure 10.28. Final appearance of imported data in Excel. 

 

NOTE: When expedient data can be copied to additional/separate sheets (also referred to as 

tabs) in the same Excel workbook/file. Descriptive titling is beneficial when using multiple 

sheets/tabs in the same file. See figure 10.29 and 10.30. 
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Figure 10.29. Renaming sheets/tabs in Excel. 

 

Figure 10.30. Completed tabs in Excel. 

 

NOTE: Excel files intended for client review should not contain internal data (or) any information 

that might confuse or confound the client. 

10.61. In the Matches tab, right click the top of the first column on the left to select that 

column. See figure 10.31 (below). 

10.62. After right clicking the top of the first column a dropdown menu is displayed. See 

figure 10.31 (below). 

10.63. From the dropdown menu select Insert. See figure 10.31 (below). 
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Figure 10.31. Inserting a new column. 

 

10.64. After selecting Insert a new column is displayed to the left of the former first column. 

See figure 10.32 (below). 

10.65. Click cell C-1 at the top of the newly inserted column and enter NOTES. See figure 

10.32 (below). 

Figure 10.32. New Notes column inserted into spreadsheet. 
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10.66. Enter any investigative notes or other pertinent information in the NOTES column as 

prosecution of the data progresses. 

10.67. Once all data is copied into the Excel file click File in the Excel menu bar at the top 

of the page. 

10.68. In the File menu click Save As. 

10.69. Click This PC in the Windows Save As dialog box to browse to a location in which to 

save the file. 

10.70. Click on the folder in which the file is to be saved in the Windows Save As dialog 

box. 

10.71. Enter a file name in the File name data entry field to name the file for the query from 

which it was generated (Matches in this example). See figure 10.33 (below). 

10.72. Click Save in the lower right corner of the Windows Save As dialog box to save the 

file to the desired location. See figure 10.33. 
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Figure 10.30. Windows Dave As dialog box with sample file location, file name, and Save highlighted. 

 

Back to section start 

Back to top 

 


